<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Login ........................................................................................ 4</td>
</tr>
<tr>
<td>Navigation and Account Settings Links ............................................... 6</td>
</tr>
<tr>
<td>View Tab ................................................................................................. 7</td>
</tr>
<tr>
<td>Legend ...................................................................................................... 7</td>
</tr>
<tr>
<td>Selecting a Date Range ........................................................................... 7</td>
</tr>
<tr>
<td>Staff Box ................................................................................................. 8</td>
</tr>
<tr>
<td>Tasks Box ................................................................................................. 8</td>
</tr>
<tr>
<td>Printing or Exporting the Schedule ...................................................... 9</td>
</tr>
<tr>
<td>Swap Tab (if enabled) ............................................................................... 11</td>
</tr>
<tr>
<td>Request Tab (if enabled) ........................................................................ 14</td>
</tr>
<tr>
<td>Statistics Tab (If Enabled) ...................................................................... 17</td>
</tr>
<tr>
<td>Using Filters for Reporting .................................................................... 18</td>
</tr>
<tr>
<td>Syncing Your Personal Schedule ............................................................ 22</td>
</tr>
<tr>
<td>Exporting Your Personal Schedule ........................................................ 23</td>
</tr>
<tr>
<td>Viewing only your Schedule .................................................................... 23</td>
</tr>
<tr>
<td>Exporting into Outlook ............................................................................ 23</td>
</tr>
<tr>
<td>Exporting into Google Calendar ............................................................ 24</td>
</tr>
<tr>
<td>Exporting into iPhone using Microsoft Outlook and Apple iTunes .......... 25</td>
</tr>
<tr>
<td>Exporting into iPhone using Google Sync ............................................. 27</td>
</tr>
<tr>
<td>Exporting into Google Calendar and viewing through the web ............ 29</td>
</tr>
<tr>
<td>Exporting into your mobile device using iSync and iCal .................. 30</td>
</tr>
<tr>
<td>Exporting into your BlackBerry using Microsoft Outlook and BlackBerry Desktop Manager .......................... 31</td>
</tr>
<tr>
<td>Exporting into your BlackBerry using Google Sync .............................. 35</td>
</tr>
<tr>
<td>QGenda Mobile ........................................................................................ 39</td>
</tr>
</tbody>
</table>
Last Modified: August 8, 2013

For all users we recommend using the Mozilla Firefox or Google Chrome browser to achieve best performance. Please note, if it asks if you want to make the new browser your default browser, say NO.
You will also need Adobe Acrobat for viewing and printing reports.

Below are the links to download and install:

Adobe Link (Both Windows & Mac):

Mozilla Firefox:

Google Chrome:
http://www.google.com/chrome

Reference to any company, names, or data contained herein is fictitious unless specifically noted. No part of this document may be transmitted or reproduced in any form or by any means, mechanical or electronic, for any purpose without the express written consent of an officer of QGenda, Inc. a non-fictitious company.

All Google products are trademarks or registered trademarks of Google Corporation, a non-fictitious company. All information contained in this document is subject to change without notice.

All Microsoft products are trademarks or registered trademarks of Microsoft Corporation, a non-fictitious company. All information contained in this document is subject to change without notice.
Initial Login

For scheduled Staff Members on the QGenda site:

2. Click “Create Account”.
3. Fill in the information, making sure to use the same email address that has been entered in QGenda – this is how it will identify to which company you belong. Click “Sign Up”. The password is case sensitive. Please make sure you remember the password you create as you will use that password and your email address to log in going forward.
4. Once you are confirmed you will log in with the email and password you specified.
5. If you log in and there is not a company listed for you to access, that means the email you entered does not match up with the one that was entered into QGenda or the Scheduling Administrator has not assigned you a profile within QGenda. You need to contact your Scheduling Administrator to have them either change the email in QGenda to match the one with which you signed up or add you to a profile under User Profiles. Once this is done you will be able to access your company.
6. The company name should then show up on your screen with the option “View”. Click this to access the schedule. Once the View Tab has loaded you will select the date range you wish to view as well as the Staff and Task Filters (from the respective drop down boxes) to populate the people and tasks on the screen.

For Non-Scheduled Users (office personnel, clinical staff that are not scheduled, etc.):

2. Click “Create Account”.
3. Fill in the information and click “Sign Up”. The password is case sensitive. Please make sure you remember the password you create as well as the email address you use as you will use that password and email address to log in going forward.
4. Once you are activated you will log in with the email and password you specified.
5. You will then need to click “Join a Company” and fill in the Phone Number and Pin Number for the company you wish to join. This information will need to be provided by your Scheduling Administrator. QGenda Staff cannot provide you with this information. Once that information is confirmed you will be granted access to the company.
6. The company name should then show up on your screen with the option “View”. Click this to access the schedule. Once the View Tab has loaded you will select the date range you wish to view as well as the Staff and Task Filters (from the respective drop down boxes) to populate the people and tasks on the screen.
Forgot Password

If you forget your password you may request a new, temporary password by clicking “Forgot Password” on the main QGenda home page.

**Prerequisites:**

- You will need access to the email account you have associated with your QGenda log in. If you do not have access to this email account, please contact QGenda Support for assistance.

- Please only enter your information into “Forgot Password” one time and wait for the email to come through. Each time you enter your information you are resetting the existing password.

Next, enter the email address with which you log in into the text box and press “Submit”

**Forgot Your Password?**

Enter your email address to receive your password.

[Submit]

You will be emailed a new password that should be copied and pasted into the password field. Log in using your existing email address and this new temporary password.

**Please note:** As soon as you request a new password through “Forgot Password”, your old password is invalid and you will only be able to log in using the most recent password that is sent to you.

Once you have successfully logged in, you may click “Change Password” in the upper right-hand corner of the screen to change your password to any string you choose.
Navigation and Account Settings Links

In the upper right-hand corner there will be four links:

Home | Change Email | Change Password | Sign Out

- Home: Takes you back to the company page.
- Change Email: Allows you to change the email address you use to log in.
- Change Password: Allows you to change the password you use to log in.
- Sign Out: Signs you out completely and will return you to the QGenda homepage.
View Tab

The View Tab is where you will view the schedules that have been published by the scheduling administrator.

Legend

In the Upper Right Hand Corner there will be a legend listing the icons you may see throughout this tab.

- **Locked**: The locked symbol on a shift means that that shift was requested on that day. Either the shift was put into the system using the Request Tab (if enabled) or the Admin entered the shift as a request.

- **Note**: The note symbol means that the shift assignment has a note from an Administrator attached to it. To see the note, hover your cursor over the icon.

An example of a locked 1st Call Assignment with a note

Selecting a Date Range

By default the View Tab Date Range will always load the current week, with Monday as the Start date and Sunday as the End date.

- Choose the Start date from the field in the top left corner. A calendar will appear when you click in the field and you will be able to select a date. You cannot type one in.

- Choose the Range you wish to see on the screen using the drop down boxes to select the number and “Days”, “Weeks”, or “Months”.

- Choose under the View By drop down box whether you wish to see.
  
  o **Staff Down Left**: Staff down the left side of the screen
  
  o **Tasks Down Left**: Tasks down the left side of the screen.
  
  o **Calendar *Staff**: A calendar view with the Staff Member’s name listed before the Shift
  
  o **Calendar *Task**: A calendar view with the Shift Name listed before the Staff Member

- Once you have selected these options, click Go.
**Staff Box**

- Click 🔄 above the drop down box to add a New Staff Filter (grouping of staff), ✅ to edit the Filter, and 🚫 to delete the Filter. Note you will not be able to Edit or Delete Filters that were created by the Scheduling Administrator.
  - When you Add a Filter, you will need to enter a Staff Filter Name in the field provided and click Add. Then you will check the checkbox next to each staff member’s name to define who is viewable with this Filter. When finished, click the 🚫 in the top right corner of the box.
  - Once you Add or Edit a Filter, QGenda will prompt you to “Please click here to refresh your changes.”
  - Note that when you create a new Filter it will be available only to you.
- The drop down box allows you to select the Staff Filter you wish to print, export, or view on the screen.
- Beneath the drop down box you will see the list of staff members within the Staff box. Next to each task there are three icons:
  - 🔄 Highlight off 🔄 Highlight on
    - Highlights (in blue) the staff member on the schedule that you have just specified. Note that you can highlight multiple staff members simultaneously. To turn off highlighting click the icon again.
  - 🔄 Show
    - Shows that person on the scheduling screen. The icon at the very top of the list will show all staff members in the staff box.
  - 🔄 Hide
    - Hides that person on the scheduling screen. The icon at the very top of the list will hide all staff members in the staff box.

**Tasks Box**

- Click 🔄 above the drop down box to add a New Task Filter (grouping of tasks), ✅ to edit the Filter, and 🚫 to delete the Filter. Note you will not be able to Edit or Delete Filters that were created by the Scheduling Administrator.
  - When you Add a Filter, you will need to enter a Task Filter Name in the field provided and click Add. Then you will click the checkbox next to each task’s name to define what is viewable with this Filter. When finished, click the 🚫 at the top right of the box.
  - Once you Add or Edit a Filter, QGenda will prompt you to “Please click here to refresh your changes”
  - Note that when you create a new Filter it will be available only to you.
- The drop down box allows you to select the Task Filter you wish to view on the screen, print or export.
Under the drop down box you will see the list of tasks. Next to each task there are two icons:

- Show
  - Shows that task on the scheduling screen. The icon at the very top of the list will show all tasks in the tasks box.
- Hide
  - Hides that task on the scheduling screen. The icon at the very top of the list will hide all tasks in the task box.

**Printing or Exporting the Schedule**

- Click the “Reports” button at the top of the screen, and the “Reports – Printing & Exporting” screen will appear.
  - Format: Choose from the following
    - PDF: opens with Adobe Reader – cannot be modified
    - Excel: opens with Microsoft Excel – can be modified as an Excel worksheet
    - Calendar – iCal Default Format: used for most current calendars such as Google Calendar and Microsoft Outlook 2007 *
    - Calendar (vCal): used for older calendar programs that are not using the current iCal standards such as Microsoft Calendar 2003 and some Palm calendars *
    - Text: saved as a comma-delimited file
  - Start Date: Click to choose the date from the pop up calendar that you want to begin viewing
  - End Date: Click to choose the date from the pop up calendar that you want to stop viewing
  - Report By: Select Staff if you wish to view the staff names down the left side of the page or Tasks if you wish to view the tasks down the left side of the page. Swaps and Requests view the input logs, respectively.
  - Show Staff By: Choose how you wish the staff names to appear
  - Show Tasks By: Choose how you wish the task names to appear

Choosing the PDF format will generate the following options for you to set

- Range: Rather than select an end date, for PDF format you must select a range that you wish to export
- Paper Size: Choose what paper size you wish to print on
- Show Color: (Yes or No) Whether you want the colors to appear or not
- Show Notes: (Yes or No) Whether or not to print the notes you have access to see
- Font Size: Select how large you would like the font to be on your PDF

* Please note that QGenda simply creates the formatted file to be exported to a calendar program. We do not have control over how your specific computer and software programs will interact with and import the file. As a general rule, when using the iCal format, it should give you the option to
automatically open into Outlook 2007 after you click Go. If you decide to Save the file then you can choose to Import the file once you have logged into your Google Calendar. We suggest either contacting an IT person within your company or calling the support for your particular software program to assist you in importing the file if it is not working properly.
**Swap Tab (if enabled)**

**Entering Swaps**

To enter a swap between you and another staff member, click the Swap link on the home page (after logging into QGenda) or click on the Swap tab at the top of the screen.

To move a task between staff members, you have two options:

1. You can left-click and hold on the Up and Down Arrow of a task and drag it to another user on the same day of the week using Drag & Drop. Once your cursor is over the cell to which you want to move the shift release the left mouse button to drop.

2. Clicking on the Up and Down Arrow will show a list of people to whom you can move the shift. Click on their name to move the task to their name.

The swap will immediately appear on the schedule with the pending symbol: 🔄.

Next, click the Submit Swap button: Submit Swap. Note that if the swap symbol 🔄 does not appear next to the task, Swapping has not been enabled for that task.

The staff member with whom you made the swap will receive an email letting them know they need to log in to QGenda to approve the swap.

- If the swap does not require admin approval the swap will be immediately published and will appear on the schedule after a refresh
- If the swap requires admin approval then the task will remain in pending status 🔄 until the Admin logs in and approves it.

**Reviewing Swaps, Approving/Rejecting Swaps, and Viewing Past Swaps**

Near the bottom of the screen you will see three tabs associated with Swapping:

- **Swap Summary**
- **Swaps Pending My Approval**
- **My Swap History**

**Swap Summary** – Shows the swaps that you have made since being logged into the system. Once you push the “Submit Swap” tab, logout, or refresh the screen, this tab will empty.
Swap Summary tab listing a swap between Cook and Elkin on 9/1/2009

**Swaps Pending My Approval** – Shows all swaps that require your attention before the admin will be notified. This is where you will go to approve or reject a swap between yourself and another staff member.

<table>
<thead>
<tr>
<th>Move</th>
<th>Task Details</th>
<th>Note</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move OR3 from Cook (LC) to Elkin (CE) on 9/1/2009</strong></td>
<td>Note:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Move HR1 from Elkin (CE) to Cook (LC) on 9/1/2009</strong></td>
<td>Note:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Swaps Pending My Approval tab listing a swap between Carne and Calista

**My Swap History** – Shows all swaps you have ever made including those that are pending and approved.

<table>
<thead>
<tr>
<th>Move</th>
<th>Task Details</th>
<th>Approval Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move 3C from Carne (HC) to Calista (JC) on 7/17/2009</strong></td>
<td>Note:</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Move HR1 from Calista (JC) to Carne (HC) on 7/17/2009</strong></td>
<td>Note:</td>
<td></td>
</tr>
</tbody>
</table>

The Swap History tab listing all swaps and their status

Tasks on the calendar that have been swapped with another user will appear in the following format:

<table>
<thead>
<tr>
<th>Task</th>
<th>Assigned Staff Member</th>
<th>Swapped Staff Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>1C</td>
<td>1C</td>
<td></td>
</tr>
<tr>
<td>2C</td>
<td>2C</td>
<td></td>
</tr>
</tbody>
</table>

...The task 1C was originally assigned to the staff member. Then a swap was entered where the staff member exchanged the 1C task for the 2C task. The  symbol next to 2C signifies that the staff member is not being tracked for the task and the strike line through 1C shows that the task is no longer being worked by the staff member. Only 2C will appear on a printed report.

Tasks on the calendar that have been swapped and require approval will appear in a pending status. Pending swaps will appear as follows for both staff members who were part of the swap: 1C

<table>
<thead>
<tr>
<th>Task</th>
<th>Assigned Staff Member</th>
<th>Swapped Staff Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>1C</td>
<td>1C</td>
<td></td>
</tr>
<tr>
<td>2C</td>
<td>2C</td>
<td></td>
</tr>
</tbody>
</table>

An example swap between Butler and Calista.
Butler had 2C originally and has traded it with Calista.
Calista receives no credit for working 2C.

12
© Copyright 2013 QGenda, Inc. All rights reserved worldwide.
QGenda Support – 770-399-9945 x 2
Viewing Swap Reports

Swap Reports will give you a detailed summary of all swaps that have been made in a specified period of time. The information will include who entered the swap, which tasks were swapped, the date and time the swap was entered, and the day for the swap. To generate a report, click the button in the upper left-hand corner of the screen labeled “Reports”. Clicking on it will open a small screen which allows you to create a PDF report of all swaps that have been made in that period of time.

Specifying Options for Swap Report

Selecting your start date will specify which day to start looking at in time and will look ahead to all swaps that have ever been made. Select your paper size, font size, and format. Currently, the default format is PDF. Click Go to create a PDF document which lists all swaps.
**Request Tab (if enabled)**

**Entering Requests**

To enter requests to your calendar click the “Request” link when you first log into the QGenda system or click the Request tab at the top of the screen once you are logged in.

To add a task to your schedule click in the cell associated with your name on the specified date. A box will appear listing all of the tasks that you can request. Click the associated task you are trying to add.

![Make a Request for](Calista, JC on 6/6/2009)

1st Call, (1C)
2nd Call, (2C)
3rd Call, (3C)
Heart Doc, (Hrt)

If the request is allowed then it will appear on the schedule with the pending symbol: \[\text{\text{\^\text{\text{\text{T}}}AC}]\]. If the addition requires admin approval, the Admin is immediately sent a notification for their approval. If the addition does not require Admin approval then the pending status will be removed and the status will change to published with a screen refresh.

If the request is not allowed then a box will appear giving you the reason why it could not be completed. The following are permissions for which the system will check before granting a request to be entered:

1. Do you have permission to add or remove the task from your schedule?
2. Does that task exist and need to be assigned on that day?
3. Has the task been assigned to someone else for that day?
4. If you already have a task on your schedule, is the task being requested compatible with the one already assigned?
5. Are there any “Must Block” rules that restrict you from receiving the task? For example, you are not allowed to work a weekend before Vacation.
6. Have you exceeded your Request Limit or Total Limit? These limits are set up by the scheduling administrator and may or may not exist.
7. Are you the last staff member available for another task?
8) Are you active to do the task (If "Check Skill" is checked by Admin)?

Keep in mind that removal requests will not be reflected under Request Limits, i.e. if you request a task for which you have a specific Request Limit, you will not get the credit back if you remove it later. However, if the limit is set under Total Limits, you will be returned the credit.

If a task is removable from your schedule it will appear with a Pink X next to the task name. Clicking the X will send the task into pending status. If the removal requires admin approval, the Admin will automatically be sent a notification email. If the removal does not require admin approval, it will appear in published status with a screen refresh.

If your request requires admin approval, you will be sent an email after the request is processed notifying you if it has been accepted or denied. If the request does not require admin approval you will be sent an email confirming the request’s automatic approval.

Viewing Requests That You Have Made

Near the bottom of the screen on the Requesting Tab you will see three tabs associated with Requesting:

- **Request Summary** – Shows the requests that you have made since being logged into the system. Logging out or doing a screen refresh will empty this tab.

- **My Request History** – Shows all requests you have ever made including those that are pending and approved.

Each request will describe if it is an addition or removal, what date the request is for, and will also include a note field that will allow you to send a short note with the request for the admin.

Add VAC to Calista (JC) on 7/6/2010  Note: [Pending Admin Approval] [Undo Request]

Add VAC to Calista (JC) on 7/5/2010  [Approved]

The non-Admin user Calista entered a request to add a vacation day to 7/6/1020

**My Request Limits** – You will be able to see how many requests you have made as well as how many you are allowed to make for yourself.

<table>
<thead>
<tr>
<th>Request Event Name</th>
<th>Date Range</th>
<th>Request Limits</th>
<th>Total Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Current</td>
<td>Max</td>
</tr>
<tr>
<td>Vacation October 2009</td>
<td>10/1/2009 - 10/31/2009</td>
<td>2</td>
<td>n/a</td>
</tr>
</tbody>
</table>

The limit showing that two requests have been entered and 4 more are allowed.
**Viewing Requesting Reports**

In the upper left-hand corner of the Request Tab you will see a button labeled “Reports”. Clicking on it will open a small screen which allows you to create PDF reports of all Requests that have ever been made.

**Request Reports**

- **Start Date**: 1/1/2010
- **End Date**: 1/31/2010
- **Paper Size**: Letter (8.5 x 11)
- **Font Size**: 8
- **Format**: PDF

Selecting your start date will specify which day to start looking at in time and will look ahead to all requests that have ever been made for that time period. Select your paper size, font size, and format. Currently, the default format is PDF. Click **Go** to create a PDF document which lists all requests.
Statistics Tab (If Enabled)

This allows you to access the statistics for your group.

- At the top left corner of the screen, select the Start and End dates using the pop-up calendar. You may also select to View By: Staff down the left side of the screen or Tasks down the left side of the screen. When selected, click Go.
- Under the Staff box you may create and select Staff Filters as described above or you may use the checkboxes to choose who you wish to view.
- Include Stats: Allows you to choose what statistics you wish to view
  - Physical – the number of times you worked a task (1 point per task)
  - Credit – the number of credit points you get for the task (the Physical number multiplied by what the Scheduling Administrator has set as the task’s worth)
    - Actual – the number of times you actually worked the task
    - Tracked – the number of time you are tracked for the task
  - These numbers may differ if tasks are bought or sold, i.e. if you sell away all of your call then you would be tracked for the full amount though you did not actually work any of them.
- The Sum By Day checkbox allows you to have a breakdown of the total amount of people working per day. Whatever tasks you have selected under the Tasks box will be tallied per day to give you the total number of people working.
- Under the Tasks box you may create and select Task Filters as described above or you may use the checkboxes to choose the tasks you wish to view.
  - Using Credit Allocation Event Filters (if enabled)
    - Credit Allocation Event Filters will be listed in Gray under the Filters drop down list. Select one of these and press “View Stats” to run the numbers for the tasks included in that Credit Allocation Event.

VIEWING THE SELECTED STATISTICS

Clicking the View Stats button will open a grid showing the allocating of each task to each staff member. If you selected “View By: Staff Down Left” you will see a listing of the staff members you have selected on the left and the top row of the grid will be the tasks you have selected by their abbreviations. If you selected “View By: Tasks Down Left” you will see a listing of the tasks you have selected down the left side of the grid and the staff members abbreviations in the top row.

- You will see a breakdown of the Physical Actual (PA), Physical Tracked (PT), Credit Actual (CA), and Credit Tracked (CT) based on which options you selected.

PRINTING THE SELECTED STATISTICS

- Clicking Print Stats button will allow you to open the statistical information in Microsoft Excel. Once inside Excel you can either Save or Print the worksheet.
Using Filters for Reporting

Once logged in each user has the ability to create Staff Filters and Task Filters for use with their account. Each filter can be considered a snap-shot of a certain group of people or tasks within the schedule and allows you to view just that particular group of Staff or Tasks on the screen. For example, you can create different Staff Filters for each Subspecialty you may have within your group and also create groups of tasks you wish to see together such as call or off tasks.

Please note: The filter you have selected will be the information that is shown and exported once you click the “Reports” Button.

The Selected Filter:
The drop down selector within each box will list the respective filters the Admin has preloaded for you as well as any filters you have created yourself. By default, the only filters created for a new account are “All Staff” and “All Tasks”. This will show as the selected filter when you first log in, and each consecutive time you log in.

![The Staff Box and Tasks Box showing the Selected Filters “All Staff” and “All Tasks” respectively](image)

Please note: Check the selected filter you are viewing if it seems that you are looking at an incomplete version of the schedule. If anything appears “missing” change your filters back to “All Staff” and/or “All Tasks”.

To create a new Staff Filter:

1) Click on the following icon in the Staff box: ![Staff Filter Icon]

2) Give the filter a name and press Add.

![Staff Filter Settings](image)

Staff Filter Settings
Staff Filter Name: [Doctors] [Add]

3) Check the Staff Members you would like to see in this filter.

![Staff Filter Settings](image)

Staff Filter Settings
Staff Filter Name: [Call Doctors]

![Staff Filter](image)

Staff
- Don Apple [✓]
- Butler [✓]

Please note: This screen shot is based on the Schedule or the Statistics tab, not the Admin tab which has more options.

See note below “Admin Using Filters”

© Copyright 2013 QGenda, Inc. All rights reserved worldwide.
QGenda Support – 770-399-9945 x 2
To create a new Task Filter:

1. Click on the following icon in the Tasks box:

2. Give the filter a name and press Add.

   Task Filter Settings
   Task Filter Name: Call Tasks
   Add

3. Check the Tasks for each day of the week you would like to see in this filter.

   Task Filter Settings
   Task Filter Name: Call Tasks
<table>
<thead>
<tr>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IC</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>GC</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>VAC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please note: This screen shot is based on the Schedule or the Statistics tab, not the Admin tab which has more options.

See note below “Admin Using Filters”

To edit a Staff Filter:

1. Select the filter you wish to modify.

2. Click on the following icon in the Staff box:

3. Check or Uncheck the Staff members you wish to see when looking at this filter:

   Staff Filter Settings
   Staff Filter Name: Call Doctors
   Staff
   |     |
   |     |
   |     |
   |     |

Please note: This screen shot is based on the Schedule or the Statistics tab, not the Admin tab which has more options.

See note below “Admin Using Filters”
To edit a Task Filter:
1. Select the filter you wish to modify.

2. Click on the following icon in the Tasks box:

3. Check or Uncheck the Tasks you wish to see when looking at this filter:

Please note: This screen shot is based on the Schedule or the Statistics tab, not the Admin tab which has more options.

See note below “Admin Using Filters”

To delete a Task Filter or a Staff Filter:
1. Select the filter you wish to delete.
2. Click on the following icon in the corresponding box:

3. QGenda will confirm the deletion. Please note: A filter deletion is permanent and cannot be undone. Press “Ok” to delete the associated filter or “Cancel” to return to the previous screen.

Showing individual Staff or Tasks:

Within the staff and task boxes there are magnifying glass icons next to each staff member or task. There will be two: one will be green and will be a “Show”: and one will be red and will be a “Hide”: .

Instead of using Filters you can use these “Hide All” Staff or Tasks from the schedule.
Then you can use the green magnifying glasses to show only the staff members or tasks you wish to see on the schedule. The filter you have selected will be the information that is shown once you click the “Reports” Button. This will make the Selected Filter change to “--Apply Staff Filter--”.

Please note: Check the selected filter you are viewing if it seems that you are looking at an incomplete version of the schedule. I.E. if anything appears “missing” change your filters back to “All Staff” and/or “All Tasks”.
Syncing Your Personal Schedule

QGenda can automatically transfer schedule assignments for the future and the most recent past weeks to your calendar. Once you’ve set up the subscription, all schedule changes will update to your personal calendar automatically.

To configure syncing, log in to QGenda and on the Home screen press “Sync”.

Next, follow the on screen instructions to configure syncing to the application or mobile device of choice.

Please note: Syncing will automatically update based on the program/mobile device you are using. A few hours can pass before the schedule will update from QGenda’s servers.
Exporting Your Personal Schedule

Please note: This is the older methodology to import a schedule to your calendar program or mobile device. Please see the section called “Syncing Your Personal Schedule” to configure automate updates to your device or program.

Viewing only your Schedule

Once logged into QGenda click on the “View” link or the View Tab.

On the left of the screen in the Staff Box, use filters to show only your name on the schedule or do the following: (For more on this see the section entitled “Using Filters for Reporting”.)

Select the “Hide All” button at the top of the staff list. This will make all the users temporarily disappear from the calendar.

Next, find your abbreviation in the list of Staff. Click the green arrow icon next to your abbreviation. The calendar should now only show your name and schedule.

Exporting into Outlook

Select the options you want and then in the Format box, select “Calendar – iCal Default Format”. Next, click the Go button. This should ask you if you want to Open or Save the file. Select “Save” and place it on your computer in an easily accessible location. Next, open Outlook and click File->Import and
Export. Click **Import an iCalendar (.ics) or a vCalendar file (.vcs)**. Click Next. Browse through your files and find the .iCal you saved. Click **OK**.

**Exporting into Google Calendar**

Select only your schedule (see instructions above).

Select the options you want and then in the Format box, select “Calendar – iCal Default Format”. Next, click the Go button. This should ask you if you want to Open or Save the File. Select “Save File” which will store the calendar on your computer.

Next, open Google calendar in your browser. In the “My calendars” box on the left side of the screen, click the “Settings” button.

This will open a screen that allows you to Create new calendars, Import calendars, or Export calendars. You will want to select the “Import Calendar” link.
A new screen will appear that will allow you to specify the file for the calendar that you saved to your computer earlier. Click the “Browse…” button and then find the file on your computer. You will also select into which Google Calendar the file should be pasted. Once the file is found and the options are selected, click the “Import” button. A screen will appear listing the number of events that were copied into the specified Google Calendar.

Exporting into iPhone using Microsoft Outlook and Apple iTunes

Export your personal schedule into Outlook (as described above).

Once the calendar is imported into Microsoft Outlook you will need to open iTunes and make sure your device is connected to your computer. (You can obtain a free copy of Apple iTunes at http://www.itunes.com).

On the left side of the screen in iTunes ensure that your iPhone is the selected device.

Inside the info tab there will be a “Calendars” section. Here you should check the options to make your calendars sync from Outlook, and also select which calendars from Outlook should be transferred.

Please note: If you had iTunes open BEFORE importing the calendar into Outlook, iTunes will not see the calendar. Be sure to import into Outlook first before opening iTunes.
Specify that the iPhone calendars should be synced with Outlook and specify which calendars should be synced. Click the Apply button in the bottom right hand corner of iTunes to save your changes. iTunes should now sync the calendar to your iPhone.

To view your schedule, click the “Calendar” application on your iPhone.

Each day with an event will be marked with a dot below the number of the day, and you will be able to see your events below the calendar.
Exporting into iPhone using Google Sync

Note: The following set of instructions and the screen shots are based off of Google’s tutorial: “Google Sync: Set Up Your iPhone or iPod Touch”.

Export your personal schedule into Google Calendar (as described above).

Once the calendar is imported into Google Calendar do the following:

Open Settings on your iPhone

Open Mail, Contacts, and Calendars

Push Add Account

Select Microsoft Exchange

In the Email field, enter your full Google Account email address. If you use an @googlemail.com address, you may see an "Unable to verify certificate" warning when you proceed to the next step.

Leave the Domain field blank.

Enter your full Google Account email address as the Username.

Enter your Google Account password as the Password.
Tap **Next** at the top of your screen.

A new **Server** field will appear. Enter **m.google.com**.

Press **Next** at the top of your screen again.

Select the Google services you want to sync. Currently only **Contacts** and **Calendar** are supported. **Make sure that you have uploaded your data before proceeding.**

Press **Sync** twice when warned about data loss.
You've set up Google Sync for your iPhone. Synchronization will begin automatically if you have Push enabled on your phone. You can also open the Calendar or Contacts app and wait a few seconds to start a sync.

**Exporting into Google Calendar and viewing through the web**

Google has support built to view your calendar on your mobile device using your browser. (See example below).

Start by exporting your schedule into Google Calendar (see instructions above).

Next, point your mobile device browser to [m.google.com/Calendar](http://m.google.com/Calendar)

Log in to Google.

Now you should see your calendars as they are set up in Google.
Exporting into your mobile device using iSync and iCal

Export your personal schedule into the iCalendar program

Once the calendar is imported into iCalendar do the following:

Add your device to iSync. Connect your device to your computer as you normally would.

Open iSync (find it in Applications folder in your Hard Drive). The iSync window displays.

Click Sync Devices and your Mac will automatically try to scan for a device nearby.

Your connected device should appear in the Add Device window. Double-click its icon to add it to the iSync window.

(An example calendar, not based on QGenda)
The iSync window displays a pane that lets you choose what information to sync to your device. If you’d like to have iSync automatically sync information whenever you connect your device, select the “Automatically synchronize when device is connected” checkbox.

Select which iCal calendars you want in the appropriate sections.

Select which iCal calendars you want in the appropriate sections.

Click Sync Devices.

Exporting into your BlackBerry using Microsoft Outlook and BlackBerry Desktop Manager

Export your personal schedule into Microsoft Outlook (see above for directions).

Open Blackberry Desktop Manager. If you need this software you should be able to obtain a copy of it at https://www.blackberry.com/Downloads/

Connect your BlackBerry device using the USB cable for your phone.
In the Desktop Manager click the Synchronize button.

On the screen titled “Synchronization” click the Synchronization button.

On the next screen select that you want to sync your calendar.

Select Microsoft Outlook and click next.
On the new few screens you will set preferences for how you would like to sync your BlackBerry.

Once completed you should see that the calendar is now associated with Outlook.

Select Device application

Select an application you want to synchronize and click Setup. After setup, you can use the check boxes to enable and disable synchronization.

Next, you will want to click the “Advanced...” button to designate which calendars should be synced with the device. Click the “Map Folder...” button.
In this screen you can navigate through the Microsoft Outlook folders box to locate the calendar you wish to sync.

Click OK, close out of each of the Advanced Screen and the Select Device application screen by clicking OK twice.

You may need to update your device now with the newest Appointments in Outlook. To do this, click the Synchronize tab on the Desktop Manager. Next, click the Synchronize button.

Your device should now be synced with Microsoft Outlook. Repeat as needed to update your BlackBerry.
Exporting into your BlackBerry using Google Sync

Note: The following set of instructions and the screen shots are based off of the following online tutorials:
1) How-to Sync Google Calendar with Your Blackberry
   http://www.googletutor.com/2008/10/16/how-to-sync-google-calendar-with-your-blackberry/

2) How to keep your BlackBerry and Google Calendars in sync
   http://www.simplehelp.net/2009/05/05/how-to-keep-your-blackberry-and-google-calendars-in-sync/

Export your personal schedule from QGenda to Google Calendar.

On your computer or phone go to the Google Sync Website http://m.google.com/sync

If on your computer, enter BlackBerry as your device and enter your phone number into the “Get it Now” box. Then press the “Send me a link” button. This will send you a text with the link you need to install Google sync.

If on your BlackBerry, simply click “Install Now” .

Click the “Download” button. You will see a downloading screen.
You will receive a confirmation on your phone.

Close your internet browser and open the calendar application on your BlackBerry.

Press the menu button and scroll up until you see “Google Sync”.

You will now enter your Google account information.
Now you will need to set up Google sync to transfer the right calendar.

On the “Last Successful Sync” page hit the menu button.

Scroll to options. Click “Sync Calendar”.

Next, scroll down and click “Sync these Calendars”.

Select all Calendars you would like to keep updated with your BlackBerry.

Once you are finished with the settings press the Escape key and Save the changes.
You will be asked if you want to sync now. Click yes to Sync.

Your BlackBerry calendar should now reflect all the items in your Google Calendar.
QGenda Mobile

On your mobile device access our main website: [http://www.qgenda.com](http://www.qgenda.com).

A login screen where you may enter your username and password should load.

Please note: If your browser loads the full version of the QGenda website please contact QGenda Technical support with the phone model and browser you are using.

Press “View” next to your group name.

QGenda.com Mobile will by default load the schedule for the current week. << Month or Month >> will take your view backward or forward one month. <Week or Week > will take your view backward one week or forward one week.